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The users must have Read and Understood, but most of all must Respect the directives 
described in this manual. 

All people coming into contact with the machine on which the numerical control is installed, 
whatever their function or whatever state the machine is in (assembly, disassembly, start-up, 
production, maintenance, repairs) must have read and understood the requirements 
concerning the security and the entirety of the directives of operation described in the manuals 
delivered with the machine. 

The operator must be properly trained to work with the machine on which the numerical 
control is installed. Improper use of the numerical control can cause heavy damage on 
equipment and/or injuries to people. 

Modification of machine parameters can cause important material damage or lead to irregular 
product quality. 

Do not expose the numerical control to excessive humidity to avoid any risk of electrocution 
and any deterioration of the equipment. 

Make sure the numerical control is disconnected from the mains power before carrying out 
any cleaning. Do not use liquids based on alcohol or ammoniac. 

In case of malfunction of the numerical control, call a technician. 

Do not expose the numerical control to direct sun rays or any other heat source. 

Do not place the numerical control in the neighbourhood of magnetic equipment such as 
transformers, motors or devices which generate interference (welding machines, etc.) 

 
 
 

 
While using this manual, you will come across the signs and icons represented here below: 
they are directly related to the safety and security of persons. Carefully follow this advice and 
inform others about it. 

 
 

This warning sign appears in the manual whenever it is necessary to pay attention to rules, 
instructions or advice. The correct sequence of operations is to be followed in order to avoid 

damage to the machine.  Symbolizes a serious personnel danger.   

 
 
This warning sign appears in this manual whenever an important information needs to be 
taken into consideration. Pay attention to this sign and follow the instructions given. 

 

 

This sign appears in this manual whenever setting instructions are given. Pay attention to this 
sign and follow the sequence of instructions given. 

 
 
This icon appears in this manual to give navigation information, to give the path to the subject 
treated in the chapter.  

General warning 

SAFETY 

Information 

Settings 

GENERAL SAFETY 

SIGNS AND ICONS APPEARING IN THIS MANUAL 

Navigation 
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Depending on software evolutions and the press brake controlled by the VisiTouch 
(configuration/capabilities), the present manual may not fully correspond to the VisiTouch that 
you currently have. However, differences are only minor. 

 

This manual describes all features of  

▪ VisiTouch 19 software version VisiTouch19_Press_PS_PC_V1.13.x and above. 

▪ MX software version 10.8.x and above. 

 

 

Intuitive Simulation  

The offline software VisiTouch MX enables in a quick, easy and efficient way, importing and 
unfolding 3D files, automatically finding solutions for tooling and bend sequences and 
simulating dynamically in 3D for checking collisions.  

 

 

PC offline software for all Cybelec controls  

Allows transferring tools and programs to CybTouch 8PS, 12PS, 15PS controls, VisiTouch 19 and 
19 MX controls and ModEva. 

 

 

 

 

  

GETTING STARTED WITH VISITOUCH 19 MX 
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There are four ways to create a program part: with the Numerical Mode, with the  
Touch Profile Mode (Graphical 2D) and with the Graphical 3D Mode (by importing or 
creating a part). This manual refers to this last one. 
 
To help you get started, here are the basic actions you are likely to do. (Follow the links to 
go directly to the tutorial video) 
 
 
 

 
 
 
 
 
 
 
 
 

Fig. 1-1: New program 
 

1. Program name 5. New graphical 2D part 
2. Menu 6. New graphical 3D part (MX) 
3. Type of program 7. Import 3D part (MX) 
4. New numerical part 8. Back 

  

INITIAL SCREEN 

CREATING A NEW 3D PART - WORKFLOW 
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Fig. 1-2: Import 3D part screen 
 

1. Current directory path 5. Drive location 
2. Folders 6. Parent folder 
3. Back 7. Display (list or large icons) 
4. Type  8. Word filter 

 
 
 
 

 Type 
▪ All supported MBT files – Only shows MBT files 
▪ Native MBT files – Only shows MBT files 
▪ 3D graphic files – Only shows MBT files 
▪ DXF / DWG – Only shows MBT files 

 
 
 
 
 

Following the import of your file, you will have to choose the material.  
After this step, you can go to the chapter Tooling Stage 
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In this chapter the machine is considered operational. The window below will appear after 
choosing a new Graphical 3D part on the main menu. 
 
 
 

In this mode, the operator can very intuitively draw a profile directly on the screen by 
touching it (please refer to the manual instruction of the VisiTouch 19 for further 
information) 

 

 

 
 
Fig. 2-1: Touch profile 
 

1. Profile name 9. Flattening 
2. Material 10. Delete all 
3. Thickness 11. Delete 
4. Radius 12. Add / Modify segment/angle 
5. Internal/external measurement 13. Show measures/angles 
6. Part length 14. Overview 
7. Tooling / OK 15. Back 
8. Try auto process 16. Zoom options 

  

3 4 5 6 2 1 

12 11 10 9 13 7 8 14 

16 

15 

DRAWING STAGE 

DRAWING A PROFILE 



 
 

User Manual 

VisiTouch MX – User Manual 

MAY 
2020 
V1.2 

9/97 

 
 
 

This is the first stage of the workflow. 
In this stage you set the tooling for the part, define how to handle collinear bends, and exclude 
bends from the sequence. 

 
 
 

 
 
 

 
Fig. 3-1: Tooling 

 
1. Full machine view 19. Trust flat 
2. Tooling view 20. Preferred 
3. User view 21. Auto tooling 
4. User view setup: Temporary view 22. Reset 
5. Animation speed 23. Overview screen 
6. Beam up/down 24. Part information 
7. Measure tool 25. Back 
8. 2D Part creation 26. Move 
9. Tooling Stage 27. Zoom forward/backward 
10. Sequencing Stage 28. Zoom - 
11. Simulation Stage 29. Zoom + 
12. Output Stage 30. Touch move 
13. File action 31. Rotate view 
14. Punch 32. Zoom menu 
15. Die 33. Orientation menu 
16. Assign all bends 34. Equipment view menu 
17. Bend number 35. Press brake 
18. Exclude 36. Part 

 

Tooling is the first stage in the process (followed by the Sequencing, Simulation, and Output stages). 
The current stage is visible in the top right corner (shown in red, above). 

Each section of the tooling screen is explained separately, according to the red outlines. 

TOOLING STAGE 
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The display window is visible in all stages (Tooling, Sequencing, Simulation and Output). 
 
 

 
 

Tapping each of the three buttons on the top right opens more options: 

 Component Visualization 

 Orientation 

 Image View 

 
 
 
These are the options available in the Component Visualization toolbar: 

 Full Machine View 

 Tooling View 

 User View 

 User View Setup: Temporary View 

 Animation 
Disable / enable animation for finger, bend movement, and placement.  
Show / hide machine outline, holes, and bend names in the simulation.  

 Beam Up / Down 

 Measure 

 
 
 
The items in the Orientation toolbar move the display so you can see the part from the angle you 
choose. Options: 

▪ Left / Right / Front / Back / Top 
▪ Bottom / Isometric Front-Left / Isometric Front-Right / Isometric Back-Left / Isometric Back-

Right 
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These are the items in the Image View toolbar: 

 Rotate the Image 

 Pan the Image 

 Zoom In and Out 

 Make the Image the Size of the Window you Draw 

 Fit the Image to the Size of the Display Window  

 
 
 

 

File action: 
▪ Save – Save the current file. 
▪ Save As – Save the current file in a different format or location. 
▪ Problem Report – Report a problem with the bending application. 
▪ Close Part – Close the file without saving. 
▪ Close Application – Terminate the bending application. 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 
Fig. 3-2: Bend data 
 

1. Bend number 17. Turned die 
2. Bend name 18. Turned die holders 
3. Type of bend 19. 180° rotation 
4. Bend length 20. Part movement 
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5. Bend angle 21. Part dimension 
6. Radius 22. Return button 
7. Hit 23. Display zoom 
8. Hit Type 24. Text zoom 
9. Indicates excluded bends 25. Zoom in/out 
10. Assigned punch tool 
11. Assigned die tool 

26. Hit row 
27. Part 

12. Whether sequenced 
13. Whether the hit has a left heel 

28. Bend number 

14. Whether the hit has a right heel 
15. Turned punch holders 

 

16. Turned punch  

 
 

 Bend Number 

 Bend Name 

 Type of Bend 
▪ Normal – A standard bend. 
▪ Hemming – A hemming bend, which translates into two distinct hits – prebend and 

flattening. 
▪ Bumping – A bumping radius bend, made by a series of shallow-angled hits 

designed to create a smooth result. 
▪ Excluded – This bend is not performed on the press brake and is excluded from the 

hit sequence. Typically, these are performed beforehand in a turret press or 
performed in a different machine setup, either before or after the current one. 

 Bend Length 

 Bend Angle 

 Radius 

 Hit 

 Hit type 
▪ Prebend – The hit is part of several hits that are needed to perform a bend, for 

example the prebend of a hemming action or a split bend. 
▪ Normal – The hit is unchanged from its design, matching its bend. 
▪ Flattening – The hit is the flattening action of the bend. 
▪ Finish – The hit is the final action that closes a bend to its design angle. 

 Indicates Excluded Bends 

 Assigned Punch Tool 

 Assigned Die Tool 

 Whether Sequenced 

 Whether the Hit has a Left Heel 

 Whether the Hit has a Right Heel 

 Turned punch holders 
Turns the punch holder and the punch connected to it 180° on the horizontal plane. 
Only active if the holder’s topmost joint is rotatable or if the clamp's joint allows this. 

 Turned punch 
Turns the punch tool 180° on the horizontal plane. Only active if the punch joint is rotatable 
or if the clamp's joint allows this (or the holder's if there is one). 

 Turned die 
Turns the die tool 180° on the horizontal plane. Only active if the die joint is rotatable. 

 Turned die holders 
Turns the die and die holder tool 180° on the horizontal plane. Only active if holder’s lowest 
joint is rotatable. 

 Whether the part is rotated by 180° on the horizontal plane before executing the Hit 
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The following example demonstrates the behaviour of tool rotation:  
 

   Legend: 
A – The upper beam. 
B – The upper clamp. The down joint type is Euro and the clamp is non- symmetric. 
C – A punch holder. The upper joint type is Euro and is not rotatable. The clamp is 
symmetric. 
D – The punch. The joint type is Euro and it is not rotatable. 

 
 
 
 
 
 
 

Combinations of the turned icons yield different results. The rotated objects are highlighted: 

Turn Punch Holder Turn Punch Both 

   
Holder and punch rotated 

together 
Punch alone rotated Holder rotated and punch 

rotated back 
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On the right (below the File button) is where you manually select the tools. 
 

 
 

Fig. 3-3: Bend data 
 

1. Punch holder 5. Block 
2. Punch 6. Table 
3. Die 7. Other 
4. Rail 8. Assign All Bends 

 
Some of these items may not be visible, depending on the components configured for your machine. 

 
Change the display: 

▪ See how the tool looks (as shown above on the left of the screen in the green box) by 
tapping one of the tools. 

▪ Reduce the number of tools displayed by tapping Filter, and then to see the complete list 
again, Touch Clear Filter. 

▪ Sort the tools by tapping By Up Joint and By Down Joint. 
▪ Some of the columns may not be visible because they are hidden on the right. To make 

them visible, Touch the Right Arrow. 
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You cannot change the information displayed below the list of tools (displayed in the red box): 
 

 
 

When you have tapped a tool, you can touch any of the other tool types on the right (such as 
Punch). The software remembers the tool you selected. 

 
 
 

The top centre of the screen shows a list of punch holder tools available on your machine. 
The punch holder display looks something like this: 

 
 

 
 

These are the columns: 

 Tool - Punch holder name. 

 Height - The height of the imported geometry. 

 M. Power - The maximum tonnage allowed for this tool. 

 Up J. - The joint type for connecting to an upper clamp or to another punch holder above. 

 Down J. - The joint type for connecting to a punch or to another punch holder below. 

 ID - Each tool has an identification (ID) number. 

 
 
 

The top centre of the screen shows a list of punch tools available on your machine. 

The punch display looks something like this:  
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These are the columns: 

 Tool - Punch name. 

 Angle - The angle of the punch's tip. 

 Radius - The radius of the punch's tip. 

 Height - The height of the imported geometry. 

 W. Height - The height for processing and calculations. (More details in Die.) 

 M. Power - The maximum tonnage allowed for this tool. 

 Hem - Specifies whether this tool can be used for hemming. 

 Up J. - The joint type for connecting to an upper clamp or to another punch holder above. 

 ID - Each tool has an identification (ID) number. 

 
 
 

The top centre of the screen shows a list of die tools available on your machine. 
The die display looks something like this: 
 
 

 
 

These are the columns: 

 Tool - Die name. 

 V-Width - The width of the die's V. 

 Angle - The angle of the die's V. 

 Radius - The radii of the die's shoulders. 

 Height - The height of the imported geometry. 

 W. Height - The working height used for processing and calculations. 
For example, DXF geometry has a height of 96.34. The tool has a 30mm tang, so the actual 
working height is 66.34. The working height for each tool type measures a different 
attribute of the geometry. In general, the working height is the distance between the 
surfaces that transfer the force of the machine, so if a tool has a tang, its height is not 
included: 

 

 
 M. Power - The maximum tonnage allowed for this tool. 

 Hem - Specifies whether this tool can be used for a hemming bend. 

 Down J. - The joint type for connecting to a lower clamp or to a holder below. 

 ID - Each tool has an identification (ID) number. 

 
 
 

The top centre of the screen shows a list of rail tools available on your machine. 
The rail display looks something like this: 
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These are the columns: 

 Tool - Rail name. 

 Height - The height of the imported geometry. 

 M. Power - The maximum tonnage allowed for this tool. 

 Up J. - The joint type for connecting to a lower clamp. 

 Down J. - The joint type for connecting to a lower beam, block, or table. 

 Manufacturer - The name of the manufacturer who builds this tool. 

 
 
 
The top centre of the screen shows a list of block tools available on your machine. 

 
 
 

 
The top centre of the screen shows a list of table tools available on your machine. 
The table display looks something like this: 

 
 

 
 

These are the columns: 

 Tool - Table name. 

 Height - The height of the imported geometry. 

 M. Power - The maximum tonnage allowed for this tool. 

 Up J. - The joint type for connecting to a lower clamp or to another die holders. 

 Down J. - The joint type for connecting to a lower beam, block, or table. 

 ID - Each tool has an identification (ID) number. 

 
 
 

The top centre of the screen shows a list of table tools available on your machine. 
The table display looks something like this:  
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These are the columns: 

 Tool - Tool name. 

 Height - The height of the imported geometry. 

 M. Power - The maximum tonnage allowed for this tool. 

 Up J. - The joint type for connecting to a lower clamp or to another die holders. 

 Down J. - The joint type for connecting to a lower beam, block, or table. 

 Manufacturer - The name of the manufacturer who builds this tool. 

 ID - Each tool has an identification (ID) number. 

 
 

 
To assign the selected tooling (for the current bend) to all the bends of the part, Touch Assign All 
Bends (on the bottom right of the screen). 
This icon is only active when you have assigned tools to at least one bend. 
When you have assigned tools to all bends, you can continue to the Sequencing Stage by tapping 
Sequence. 

 
 
 
 

 
 
 
 

 
 

You can filter the list of tools, so you see only those that answer specific criteria. 
 

 Touch Filter and set the parameters. 

 To cancel the filter, Touch Clear Filter. 

 When connecting tools such as a die and a die holder, you need to know which joint type 
matches your machine's clamping. To help you, sort by joint type (by tapping By Up Joint or 
By Down Joint). 
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At the bottom of the manual tool selection screen are the actions you can take: 
 

 Information 

 Remove Tools – Remove tools from the selection showing in the middle of the screen 

 Assigned – You can define the assigned tools in Settings => Machine => Punches / Dies / 
Holders. 

 Favourite – You can define favourite tools in Menu => … => Service => Parameters => 
Machine Dimensions => Edit 3D machine definition => Punches / Dies / holders and check 
the checkboxes in the Favourite column.  

 

 
 

 By Bend Table – Show the tools that are compatible with the material, thickness, bend 
radius, and angle. 

 To use the selected tool for all bends, make sure Assign all is highlighted (with a dark 
background). 

 
When you have selected acceptable tools (e.g., with correct stacking) to continue to the next stage, 
the OK button turns green. 
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At the bottom of the tooling screen are the options for automatic tool selection:  

 To cancel the tool selection, Touch Back. You will be prompted to save or discard your tool 
selections. 

 Part Information 

 To see all the data regarding the bends, Touch Overview. 

 To reset the tool selections and continue working in this screen, Touch Reset. 

 To instruct the bending software to automatically select tools for the part, Touch Auto. 

 Preferred 
Set tools as the default for a specific combination of machine + materials + thickness 

 

Add preferred tools in Settings => Machines => Preferred. 

 Stations 
Allows you to apply a previously saved tool setup. 

 Trust Flat 
Select this option when you do not want the size of the flat to change as a result of the 
selected tools. 

 Exclude 
Allows you to exclude desired hits. Any bend you touch is bent, its tooling is discarded, and 
it is added to the excluded list. 

 To Bumped 
Allows you to bump hits that almost always have a large radius. The bumping is a series of 
shallow-angled hits designed to create a smooth result. 

 Bumping Setup 
A window opens where you define the bumping steps, pitch, and method for the bend. 

 Collinear 
A group of two or more bends that can be created with a single hit. 

 Bend Number 

 
When you have the desired tools, go to the Sequencing Stage by tapping Sequence. 
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 Exclude 
This option allows defining hits as excluded. Any bend on which you touch, its tooling is 
discarded, and it is added to the excluded list. 
Excluded bends are not intended to be in the bend sequence. 

These bends are always placed at the beginning of the sequence and are not 
available in the Hit Sequencing panel.  

They are usually 
▪ For bends that are done before the sequence. 
▪ A different sequence of hits that are done in a separate setup or on a different 

machine. 
An example of an excluded bend is hemming bends, which are sometimes done separately 
from the rest of the bends in the part due to tooling or machine considerations. 
 
To exclude bends, Touch Exclude Bends; you are now in the Exclusion Mode. Any bend you 
Touch is bent, its tooling is discarded, and it is added to the excluded list. 

VisiTouch 19 MX assumes that excluded bends are bent prior to the VisiTouch 19 
MX simulation. Note that excluded bends are different from untooled hits, which 
can be placed before or after the other bends. 

To exit this mode, Touch the Exclude Bends button again. 
 
To reverse the exclusion, re-enter the Exclusion Mode and Touch the bend again. 

▪ For example, in the following part, bend 1 is done on a different machine; 
therefore, it is excluded: 

 
 
 
 

 To Bumped 
Allows users to bump desired hits, almost exclusively with a large radius, which is made by a 
series of shallow-angled hits designed to create a smooth result. 

 
Instead of one hit with a very large V die: 

 
 
Several hits with a smaller V achieve the smooth bend: 
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Exclude 
 
 

To Bumped 
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Convert Bumped to Normal: 
Converting a bumped bend to a normal bend is useful for cases where a large V die, and 
large radius punch are available to perform the bend. 
This option is only active when you highlight a bumped bend. 
 
Convert to Bumped: 
Converting a normal bend to a bumped bend is useful for cases where a bend is not 
automatically set as bumped. 
When you Touch this icon, the Bumping Radius Setup dialog box opens, and you can define 
the bumping steps, pitch, and method for the bend. 

 
 
 

A window opens and you can define the bumping steps, pitch, and method for the bend: 

 

 

 Bend Info 
This area displays information about the bend: the radius, angle, and tools (if any) 

 Radius Pitch Method Section 
Here you can determine the method used to create the bumping: 

The Steps Number and the Pitch are two parts of the same bumping calculation; when 
there are more steps (hits), the pitch is smaller. Conversely, when the pitch is bigger, 
the bend requires fewer steps. 

 
Steps Number 
Specify the number of steps (hits) to use in the bumping 
When there are more steps, the pitch is smaller, and the result is smoother. 
 
Pitch 
Specify the distance between the hits in the bumping 
When the hits are closer, the result is smoother, but more hits are required to achieve 
the bend. 
 
Tooling 
Specify which tools to use in the bumping 
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Use the Select Tools button to open the dialog box for tool selection.  
The V width of the die is used to calculate the smallest possible pitch. 
After the tool selection, you can always edit the number of steps if this calculation gives 
too many. This does not remove the tooling definition. 

 Step Angle Method Section 
Here you can set how the defined pitch and the bend angle are distributed along the bend's 
arc. 
 

All Angles Equal 
All angles and pitches are equal 

 
First and last different 
All pitches are equal, but the first and last angles are half of the central ones: 
This gives a smoother start and end for the resulting bend. 

 
First two and last two different 
Start and end angles and pitches are different from the central ones: 
▪ The first and last angles are a quarter of the central angles. Their pitches are half 

of the central angles. 
▪ The second and second-from-last angles have the same pitch. Their angles are 

three-quarters of the central angles. 
 
 
 

A group of two or more bends that can be created with a single hit. Touch Collinear to 
manage collinear bends: 

 

▪ Each group of collinear bends is color-coded to make split groups easy to recognize. 

▪ You may want to perform the collinear bends in two hits: one for Bends 5, 9, and 16. 

▪ To do this, uncheck Bend 5 from the group, thereby causing a new line to be opened 
for it (since it is a new group): 
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▪ When your part has several groups, you may want to view only one of them. To 
select one group, Touch the Filter button: 

 

 

▪ When you have the desired tools, go to the Sequencing Stage by tapping Sequence. 
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Fig. 3-4: Auto tooling selection screen 
 

1. Row number 1. Tested 
2. Result 2. Punch visualization 
3. Punch name 3. Die visualization 
4. PHs number 4. Ok 
5. Die name 5. Cancel 
6. Die V-Index 6. Preferred 
7. V-Opening 7. Combination result visualization 
8. DHs number 8. Simulation start 
9. Radius 9. Simulation type 
10. Result 10. Setup 
11. Comments 11. Part information 

 

The options in this screen: 

 Setup 
Opens the Auto Tooling Setup screen. 

 Fast 
Automatically chooses tooling for the bends in the part based on the following tests: 

▪ Tool tonnage 
▪ The radius that results from the tools, within the Bend Radius Testing Tolerance 
▪ Tooling height 
▪ The need for holders to connect the tools to the clamps. 

 
Full 
Performs the same checks as the Fast option, but in addition it tries to find a viable bend 
sequence, based on the Collision Settings. 

 Start 
Begins the search for compatible tools. Searches only the selected joint types. 

 All 
Selects all joint types so that when you Touch Start, the search runs on all the joint types 
(not just the selected joint types). 
 
Usable / Succeeded / Suitable 
Filters the visible results: 

▪ Usable combines both succeeded and suitable results. 
▪ Succeeded are all possible results, with all available segments. 
▪ Suitable are all possible results, without enough segments. 

 

 Preferred  
The default tools for a specific combination of machine + materials + thickness. 
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When the bending program selects the tools automatically, it uses these defined limitations. 

 

 Tool Selection Mode 
Fast / Full Mode 

 Auto Tooling Parameters 
▪ Bend Radius Testing Tolerance 

The bending application uses this tolerance to test the resulting radius of a given set 
of tools. This testing parallels the testing for the manual tool selection's Resulting 
Radius. 
 

▪ Allow Punch Tip to Determine Bend Radius 
The die usually determines the bend radius. When you select this option, the punch 
tip plays a part. There may be implications to allowing the punch tip. 
As long as the punch's radius is smaller than the resulting radius then you get a good 
bend: 

 
 
 
However, when the radius of the punch is larger than the one you would expect to get from 
the die's width, problems ensue: 
 

▪ If the punch radius is larger than the expected resulting radius, but smaller than 
the die, you get a 4-point bend, with the resulting material deformation: 
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▪ If the punch radius is larger than the die's width, you do not even get the correct 
angle: 

 
The punch cannot penetrate low enough into the die, and instead of the desired 90° 
angle, you get an incomplete bend. 
 

Use Preferred Holders Only 
This option is available only if there are preferred tools for this material. 

When this option is selected, the automatic tool selection process only uses the holders 
from the Preferred set when testing tools. 

 
Maximum Punch and Die Holders 

This option is not available when you select the Use Preferred Holders Only option. 
These settings determine how many holders to use when testing how possible tooling 
combinations fit on the clamps. 
Example of a die holder with another holder: 

 
 
 
 
 

 Punches / Dies Tabs 
You can change the display and select tools: 

▪ Filter the list of tools shown in these tabs by tapping the Filter button and defining 
conditions. Additional options: 

Define more than one filter. 
Use the tools resulting from the filter by tapping Shown tools. 
Remove the filter(s) by tapping Clear Filter. 
 

▪ Sort the list of tools using the By Up/Down Joint buttons. 
▪ Select All / None tools from the list. 
▪ By Bend Table – When selected, shows only the tools that are compatible with the 

material, thickness, bend radius, and angle. 
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In this stage you determine the order of the hits that create the bends and adjust the positions of 
the finger stops. You can only progress to the Sequencing Stage once you have determined the tools 
for each bend in the Tooling Stage. 

Each bend consists of one or more hits. For example, a hemming bend may require a pre-bend hit 
and then a flattening hit. And a bumping bend consists of at least two hits. 

 

 

 

 
Fig. 4-1: Auto hit sequencing screen 
 

1. Hit menu 5. Manual order 
2. Finger control 6. Auto setup 
3. All hits 7. Auto 
4. Split 8. Reset 
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Touch Auto so the software can calculate the most efficient order 

 

 

 

 

 

 

 

 

 

 

 

 

  
 
 
Fig. 4-2: Auto hit sequencing selection screen 
 

1. Row number 10. Number of parts in machine 
2. Result 11. Result 
3. Order of the hits 12. Tested 
4. Sum of total rotation 13. Validation 
5. Largest gauging 14. Cancel 
6. Average gauging 15. Filter 
7. Diagonal gauging 16. Start 
8. Sum of total flips 17. Part information 
9. Number of stations required  

 
The table shows these columns: 

 #  
The Row number 

 Sequence 
The order of the hits. 

 Total Rotation 
The sum of all part rotations, in degrees. 

 Largest Gauging # 
Gauge # is the number of bent bends between the current hit and the furthermost point on 
the X axis, so this column shows the largest gauge number. 

 Average Gauging # 
The average of the gauge numbers of the hits in this alternative. 

 # Diagonal Gauging 
The number of hits that have a diagonal flange adjacent to the finger, as in the following 
example: 
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 # Flips 
Indicates how many times the user must flip the part. 

 Tool Stations # 
The number of stations required. 

 Result 
Indicates if this alternative is OK or only partially suitable (i.e., contains segment errors). 

Back – closes auto sequencing screen without selecting a sequence. 
Start – start auto sequencing (search starts automatically when no prior results 
exist). 
Usable – show both suitable and succeeded results. 
Succeeded – filter the results list to show only succeeded results. 
Suitable - filter the results list to show only suitable results. 
Stop – stop auto sequencing. 
OK – accept selected sequence and go back to simulation screen. 

 
 
 

Here we can configure different settings controlling the auto sequencing process: 

 

 

 Automatic Sequencing Parameters 
▪ Build Tool Stations 

When this option is enabled, VisiTouch 19 MX checks if the tested tooling set has the 
segmentation needed to create the tool stations for bending the part. 

 
▪ Split Hits before Sequencing 

When this option is checked, VisiTouch 19 MX splits hits prior to the auto-sequencing 
process. This option is particularly applicable when your part is obviously requires 
splits, which may cause the auto-sequencing to time out (according to the Limit auto 
sequence execution time option). 
Example of a typical part requiring splits: 
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▪ Use Negative Tolerance 
When selecting tool segments to fit the length of a hit, the bending application may not 
find the exact match. The Negative Tolerance allows the bending application to select 
segments that cover less than the hit length, within this tolerance. 
For example, a Negative Tolerance of 5mm allows the bending application to select a 
segment of 200mm to fit a hit with a length of 204mm: 

 
The default value is set in the Tools Configuration => General tab, in Negative tolerance 
in tool stations. 

 Untooled Hits Mode 
Choose where to sequence untooled hits: 
▪ First – Sequence the untooled hits before the tooled hits, as if they are to be bent on a 

previous operation 
▪ Regular – Sequence the untooled hits as needed to avoid collisions. 
▪ Last – Sequence the untooled hits after the tooled hits, as if they will be bent on a next 

operation. 
 
 
 

These options enable and disable the various collision testing options that will be used during the 
automatic sequencing feature. 
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Allows you to Touch the bends in the 3D graphical representation of the part, thereby adding them 
to the hit sequence. If you have already defined a hit sequence, you must first approve its deletion. 
When you enter this mode, Undo becomes visible. (After you Touch one or more bends to add them 
to the sequence, this option allows you to undo the last hit.) 

Tapping the bend name button in the lower right corner shows the hits sequenced so far. 

To accept the sequence, Touch Finish. 
 
 
 

 

 
 
Fig. 4-3: Auto hit sequencing selection screen 

  

MANUAL MODE 

2D Sequencing 
 
 

1 

2 

3 

4 

5 

6 

7 

8 9 18 16 19 10 11 12 13 14 15 17 20 

3D Forward 
Sequencing 



 

User Manual 

VisiTouch MX – User Manual 

MAY 
2020 
V1.2 

34/97 

1. Left Heel 11. Automatic Bend Order 
2. Right Heel 12. Options 
3. Rotate Part 13. Manually Bend Order 
4. Rotate Tools 14. Split 
5. Rename 15. Merge 
6. Gauges Movement 16. Reverse 
7. Assign All 17. Play 
8. Information 18. Simulation 
9. Description Part 19. Play 
10. Reset 20. Simulation 

 

Allows you to Touch bends in the 3D graphical representation of the part, thereby adding them to 
the hit sequence. If you have already defined a hit sequence, you must first approve its deletion. 
When you enter this mode, two additional icons become visible: 

▪ Undo - After you Touch one or more bends to add them to the sequence, allows you to 
delete the last hit. 

▪ Tapping the bend name button in the lower right corner shows the hits sequenced so far. 

▪ To accept the sequence, Touch Finish. 
 
 
 

Opens a screen where you can perform all the rotate and move manipulations described in Hit 
Sequencing. This is a quick manual method, where VisiTouch 19 MX does not recalculate and update 
the graphic display after each change: 
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In the Sequencing Stage, the finger is in an absolute position on the machine. 

Finger management is also possible in the Simulation Stage. 

To make changes to the finger definitions: 

▪ Drag the fingers in the graphic display. You can only drag the fingers in the Z axis. 

▪ Touch the Sequence / Simulation tab and Touch Finger Control. In the dialog box that 
opens, you control the exact placement of the fingers. VisiTouch 19 MX performs 
calculations for you, and you can make changes. 

 
To close the control button, Touch Finger Control again 

 
 

Fig. 4-4: Auto hit sequencing selection screen 

 
1. Finger Control 6. X Finger Movement 
2. Finger  7. R Finger Movement 
3. Stop  8. Z Finger Movement 
4. Get Next Finger Position 9. Retract 
5. Get Previous Finger Position 10. Position 

 
 

 Finger 
Select 1 or 2, indicating the first and second fingers. 

 Stop 
The place on the finger that stabilizes the part. Select a finger stop position from among the 
possible options. The graphic display changes accordingly. 

 Get previous finger position 
Moves the selected finger to the previously available position (for any stop). If you are at 
the first position, VisiTouch 19 MX moves to the last available position. If moving the 
selected finger affects the other finger, it moves too (unless it is locked). 

 Get next finger position 
Moves the selected finger to the next available position (for any stop). If you are at the last 
position, VisiTouch 19 MX shows you the first available position. If moving the selected 
finger affects the other finger, it moves too (unless it is locked). 
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When you Touch one of the axis positions, the name of the active field changes to red, e.g., 
R. 
 
You can change the values in this section in several ways: 

▪ Touch one of the values and drag the slider to the right and the left: 
▪ Type a value in the field. 
▪ Use the plus and minus signs to manoeuvre the finger. 

 
VisiTouch 19 MX allows you to change the finger positions along the X, R, and Z axes. 
 
All machines have Z1 and Z2 axes, with at least one R and one X axes. The number of axes 
and their limitations depend on the machine's configuration. 
 
X axis: 

▪ Retract – VisiTouch 19 MX moves the fingers backwards before the hit, according 
to this value. Modes for the selected bend: 

o Unselected – Manual Retract Mode, i.e., you are manually changing the 
retraction value. 

o Selected – Auto Retract Mode, i.e., the retraction value is automatically 
set. 

 
R axis: 

▪ R1 – Moves the finger up and down (or if the machine supports it, moves only the 
left finger). 

▪ R2 – (For machines that support this.) Moves the right finger up and down. 
 
Z axis: 

▪ Z1 – Moves the left finger sideways, relative to the zero position. 
▪ Set current Z position for all next hits – VisiTouch 19 MX copies the Z position you 

define here as the finger position for all the subsequent hits. 
▪ Z2 – (For machines that support this.) Moves the right finger sideways, relative to 

the zero position. 
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This section explains the options available when in the Simulation Stage, the areas of the screen, and 
the changing views. 

 

 

In this stage, the bending application assigns tools with specific lengths, called segments, according 
to your inventory. The bending application sets up the smallest number of stations possible, 
depending on the shape of the part, your inventory, and the order of the hits. 

If the sequence for the part was found using Auto Sequence, then the tool stations and 
segmentation are already calculated. 

You can run through all the hits, checking for potential conflicts. When you are satisfied, you can 
create screenshots to insert into your report. 

You can only progress to the Output Stage once you have played the simulation through to the end 
in this stage. 

If you do not want to simulate a specific hit (for example if you have already done so 
previously) you can skip it by tapping the icon. 

The Overview and Reset buttons are explained elsewhere. 

 

 

 

 

 

 

 

 

 

 

 

 
  
 

 
Fig. 5-1: Simulation stage screen 

 
1. Simulation Stage 11. Auto capture 
2. Output Stage 12. Single play mode 
3. Hit parameters 13. Play 
4. Tool stations 14. Go to next 
5. Alignment management 15. Go to previous 
6. Finger control 16. Go to first 
7. Save setup 17. Reset 
8. Output 18. Overview 
9. Bend number 19. Part information 
10. Manual capture 20. Back 
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In this section you can play and replay the hits in the simulated design using the arrow keys: 

 Go to First 
Goes to the start of the simulation. 

 Go to Previous 
Goes to the previous hit. 

 Go to Next 
Goes to the next hit. 

 Play 
Simulates bending the hits, continuously or one by one, depending if Single Play Mode is 
active. 

 Single Play Mode 
If active, Play simulates the hits one by one. 
If the bending application detects a collision, you will see this warning: 
 

 
 

▪ Continue – Continue the simulation, ignoring this collision. 
▪ Skip – Continue the simulation, ignoring all collisions in this hit. 
▪ Revert – Stop the simulation, staying in the current hit. 

 
 
 
To manually select the images for showing the individual hits in the Setup Report, Touch these 
buttons. 
 

 Auto Capture 
The bending application takes a screen shot of every hit as it is played (or skipped), using 
the current zoom and angle. 

 Manual Capture 
Takes a screen shot for the current hit only. 

 
 
 
To see the details of all the hits, Touch the Hit Parameters button. A dialog box opens. You can 
add descriptive information in the Hit Comments column. 
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To edit existing axis and other hit values, Touch the Allow Edit button and Touch one of the values. 
Touch a new value.  
To set the current values for all subsequent hits: 

1. Touch the Allow Edit button. 
2. Set a new value. The Propagate button becomes active. 
3. To set the subsequent values to match the current one, Touch the button. 

 
For example, starting from these values: 

 
 
Using Propagate for the Z1 value of Hit 1 (1,800.00) results in these values: 

 
 
 
 
This window lists all the stations in your simulation, allowing you to review and change station 
positions, segment positions and part positions on the stations:  
 
There are two forms of selection in the Tool Stations: 

▪ Station selection (default) – Tapping any part of the station selects it all (highlighted by 
a red outline): 

Allow Edit 
Button 
 

Tool 
Stations 
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▪ Segment selection – To select individual segments in a station, Touch twice quickly (not 
directly on a station): 

 
 
The Tool Stations window allows different actions, depending on your selection. 
 
When you select a station, the Stations option opens: 

 
 

If you select a specific punch segment, the Tools option opens with the segment selected for 
editing (moving or removing): 

 
 
 
Positioning in Tool Stations 
This area of the window enables you to set the position of items in the Tools Stations window, e.g., 
stations, clamps, and tool segments: 
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Positioning Reference 
This dropdown menu sets to which part of the item the numerical positioning value refers: 

 
 
Numerical Position 
This field sets the position of the selected item (station, tool segment, hit). 
When you move the item (using the slider, the position arrows, or by dragging), it is reflected in 
this field. 
Tapping the field opens a keyboard for entering a new value: 

 
 
Left and Right Movement Arrow  
To move the selected item to the left/Right, Touch the Left / Right Movement button   
A single Touch moves it 5 mm. Continuous tapping results in continuous movement. 

 
Movement Slider 
This slider controls the position of the selected item. 
The numbers at either side show the limit of the movement: 

 
 
In the picture above the die segment is at the leftmost limit of its movement, as it is bound by the 
segment on its left, so the slider cannot be moved leftwards. 
The movement rightwards, in contrast, is free, to the limit of the machine’s length. 

 
Align to Machine Centre Button 
To move the selected item to the centre of the machine, Touch the Align to Machine Centre 
button. 

This button is enabled only when the selected item is the only one of its kind in the 
setup, e.g., a station when it is the only one. 
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Segment Addition and Removal 
After selecting a station and tooling (punch, die, holder) you can change the segmentation, adding 
or removing individual pieces: 

 
 
Removing a Segment 
To remove a segment, touch it and Touch the Del button next to it. 

 
Adding a Segment 
To add a segment: 

Touch an existing segment. 
Touch the quantity (not its length) of the segment to add. 
In the following picture the 50-die segment is selected for addition: 

 
 

You can only add a segment if the quantity is greater than 0. 
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Touch the Before  or After  buttons to position the segment in relation to the 
existing one. 

 
For example, if the current setup is this: 

 
 
 
Before: 

 
 
After: 

 
 

 
Gap Addition and Removal 
You can add or remove a gap between segments in two ways: 

▪ Dragging – Drag a segment away from another. A gap is added automatically between 
them. Drag a segment to touch another and the gap is removed. 

▪ Using the Before and After buttons. 
 
Removing a Gap: To remove a gap, Touch the one you want and Touch the Del button next to it. 
 
Adding a Gap: To add a segment: 

Touch the segment next to which you want to add the gap. 
Touch inside the Gap field and the keyboard will open. enter the length of the gap you wish 
to add: 
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To set the positions of upper clamp or remove them from the current setup, Touch the U Clamps 
button: 

 

 
 

This button is active only if the upper clamping is separated into individual clamps – if there is only a 
continuous clamp, e.g., Wila clamping, then it will be disabled. 
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Remove Button 
To remove the clamp from the setup, e.g., to avoid a collision with the part, Touch the Remove 
button. 
The removed clamps will be marked in the list with a red background: 

 
 
 
 

To see and edit details of the hits and stations, Touch the Stations button. The Stations Setup dialog 
box opens. 
 

You can also Touch the station itself to get to this window. 

 

 
 
Examples of modifications you can make: 

▪ Slide the stations to the right and the left in the graphic at the top. 
▪ Change the position of the selected station by typing a new value on the right. 

Stations 
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▪ Switch the length or position of a particular station with the station on the right/left side. 
▪ Change the gap. 
▪ Align parts with punch or die tools. 
▪ Transfer hits from one station to another. 
▪ Exclude a clamp from the upper or lower beam. 
▪ Change the clamp’s current position. 

The following sections discuss the buttons outlined in green, above. 

 
Station Selection 
To select a station, Touch it in the graphic section: 

 
 
Or select it from the station dropdown: 

 
 
Switch Button 
To switch the positions between two stations, Touch the Switch button. 
Select to switch left or right stations: 

 
 
If the selected station is the rightmost, then the Switch with Right Side Station option is disabled, 
same for Switch with Left. 

 
U Holders 
To change the positions and quantities of the upper holders, Touch the U Holders button: 
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Tools 
To change the positions and segmentation of the punches and dies, Touch the Tools button: 

 

 
 

Punches 
To change the positions and segmentation of the punches, Touch the Punches button. 
The window that opens shows these things: 
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▪ The segment in use 

 
 

▪ Overall segment availability: if “0” is showing then you cannot add this segment to the 
setup: 

 
 

o Normal – The number of available regular (straight sides) segments. 
o Left Heel – The number of available left heel segments. 
o Right Heel – The number of available right heel segments. 

 
Dies 
To change the positions and segmentation of the dies, Touch the Dies button. 
A window opens, showing these things: 

▪ The segments in use: 

 
 
 

▪ Overall segment availability: if "0" is showing then you cannot add this segment to the 
setup: 

 
 
Align Tool Options 
To align the punch segments to the die segments (and vice versa), Touch the Align button. A 
dropdown menu opens: 
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Tapping the Punches button causes them to move so they are aligned with the dies. 
Tapping the Dies button causes them to be aligned with the punches. 
The alignment functionality on the punches has the following results: 
 

Align Centre Align Left Align Right 

   
 

L Holders 
To change the positions and segmentation of the lower holders, Touch the L Holders button: 
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When there is only one type of holder, e.g., for a single V die, then there is only one column of 
holders: 

 

 
 
The segmentation handling is the same as for the Punches and the Dies. 

 
Hits 
To change the position of the part for individual hits, Touch the Hits button. 
The list of hits shows the hits that are performed on the current tool station: 

 
 
Move Part with Station 

▪ When Move Part with Station is enabled, the part moves together with the station when 
the station moves. 

▪ When this option is disabled, the part remains in place.  
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Align Hits Options 
▪ This section allows you to align the part to the punch or to the die: 

 
 

Align Left to the Punch results in this: 

 
 

Align Right to the Punch results in this: 

 
 

Align Right to the Die results in this: 

 
 
Transfer Mode 
To transfer hits between stations and create new stations, Touch the Transfer Mode button: 

 
 
To Transfer one or more hits: 

Select a single hit or several from the hits list. 
In the Transfer hit(s) to dropdown list, Touch the station to transfer to: 

 
Touch the Transfer button. 
 

To create a New Station: 
Touch the hit for which to create the station. 
Touch the New Station button. 

 
 
 
To set the positions of upper/lower clamps or remove them from the current setup, Touch the L 
Clamps button: 

  

L Clamps 
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This button is active only if the upper clamping is sectioned into individual clamps. If there is only a 
continuous clamp, e.g., Wila clamping, then the button is disabled. 

 
Remove Lower Clamp 
To remove the clamp from the setup, e.g., to avoid a collision with the part, Touch the Remove 
button. The removed clamps will be marked in the list with a red background: 

 
 

Finger Control 
In the Simulation Stage, the bending application positions the finger relative to the part. 
For more information, see Finger Management in the Sequencing Stage. 

 
Save 
The Save button saves the current setup of use in future parts. 
This button becomes active only after you have run the simulation through to the end. This ensures 
that you have seen the simulation and are aware of what will happen, before you save the tooling 
setup you have defined. 
You must give your setup a name. You can then use this tooling setup for another part. 

 
Lock Tool Stations 
The Lock Tool Stations button allows you to lock the current tooling setup. 
This is used to prevent the bending application from recalculating the setup after changes in the 
Sequencing Stage. 
This is useful when you have made manual changes to the setup that was calculated automatically, 
and you wish to keep these changes from being erased. 
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This is the last stage of the process. In this stage, VisiTouch 19 MX generates the NC code. 

 
 

 

 
 

 
Fig. 6-1: Output stage screen 

 
1. Stations 5. Reset 
2. Back 6. Information 
3. Part Information 7. Name-On-Control 
4. Overview  8. Validation 

 

 
 
Fig. 6-2: Info screen 

OUTPUT STAGE 

OUTPUT SCREEN 

1 
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Here you will find the main screen of the machine configuration. 

 
 

 
 
 
 

Fig. 6-1: Main menu 
 

1. Orientation view 13. Import machine menu 
2. Material management 14. NC Output management 
3. Punch management 15. Lower / Upper clamp configuration 
4. Die management 16. R axis configuration 
5. Upper clamp management 17. General machine parameters 
6. Lower clamp management 18. Main menu 
7. Hemming management 19. Back button 
8. Preferred tools menu 20. Machine components menu 
9. Fingers management 21. Equipment’s name 
10. Tool station setup 22. Load machine from library 
11. Colours management 23. Edit machine component 
12. 3D / Static view 24. Select machine component 
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Here you can select other components from dropdown lists, and open all the possible options for 
the components in a separate window. 
 
For example, to make changes to the upper clamps' definitions or add new ones, Touch the New 
Clamps icon: 
 
The icons in these dialog boxes allow you to refresh the list of displayed components, add a new 
one, and more: copy or edit an existing one, and see a graphical preview in a separate window: 

 
 

 
 

1. List of Upper Clamps 9. Change Manufacturer 
2. Refresh 10. Rename Manufacturer 
3. Define New Upper Clamp  11. Export 
4. Import Upper Clamp (*.mbmUC) 12. Preview 
5. Copy 13. Delete the component 
6. Reload 14. Close the window 
7. Edit 15. Select the Upper Clamp 
8. Rename  

 
 
Here you configure general machine settings. 
 
General Machine Parameters Section 

 

 

Components 
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 Bending power 
The maximum load or pressure. 

 Max. bend length 
The maximum length of the bend. 

 Y safety opening 
The mute position (also called the speed change position) of the die. If not defined for a 
particular die, this is the default. 

 Minimum opening 
The minimum top dead center (TDC) between bends. When added to the Y safety opening, 
indicates the actual opening. 

 Maximum opening height 
Between the upper and lower beams. 

 Minimum opening height 
Between the upper and lower beams. 

 Limit punch / die angle difference 
Select this option if your machine restricts the difference in punch/die angles. 

 Punch / die angle difference limit 
The allowed tolerance angle between punch and die. Only available when Limit punch/die 
angle difference is selected. 

 Tandem machine 

 Z offset of second machine 

 
 

Floor Parameters Section 
 

 
 
You can take the floor into account for collisions by changing the floor measurements for Distance 
from beam, X dimension, and Z dimension.  
 
You can then see a visual representation of the floor relative to the machine when you load the 
program: 
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Axes Configuration 

 
 
In this section you define dependencies between axes. 
Add Finger opens an additional finger (with Z, X and R axes). 
 
You also have these options: 

▪ Copy Finger 
▪ Delete Finger 
▪ Move Up/Down – Changes the order of the fingers. 
▪ Expand/Collapse All – Changes the amount of detail displayed 

 
R axis reference point – Controls the up and down movement. This option defines the origin for the  
 
R axis as defined on the machine. Select one: 

▪ Top of lower beam 
▪ Top of lower clamp system 
▪ Top of die 

 
Z axis origin – Options: Origin at left of beam, or Origin at centre of beam. 
 
X axis controls the front and back movement. 
 
R axis controls the up and down movement. 

Parameters for each Z axis: 
▪ Order – The name of the finger. 
▪ Min and Max – The limitations of the finger positions on the Z axis, relative to the Z axis 

origin. 
▪ Default – The default position. 
▪ Right offset – The minimum distance between this finger and the finger to the right. 
▪ Finger – Select one from the dropdown list. 
▪ dZ Reference – Moves the finger reference point by this value on the Z axis. 
▪ Control – Controlled by NC or manually. 

 
 
Extra Axes Configuration 

▪ I Axis Supported – For machines that can move the lower beam back and forth. 
▪ Pneumatic hemming die supported – Allows pneumatic hemming die support. 
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Clamps 
 

 
 

 Min. tool stations gap 
The minimum gap between tool stations during the Simulation Stage. 

 Upper clamps start/end offset. 

 Upper clamps sections 
Allows defining the number of upper clamps. 

 Number of upper clamps 
Only available when Upper clamps sections is checked. 

 Lower clamps start/end offset. 

 Lower clamps sections 
Allows defining the number of lower clamps. 

 Number of lower clamps 
Only available when Lower clamps sections is checked. 

 
 
Automatic name-on-control options: 

▪ Tools name-on-control – Sets the names of assigned tools or materials to name-on-control 
names. 

▪ Materials name-on-control – Sets the names of materials to name-on-control names. 

 
 
Load 
Loads a new machine configuration: 

▪ Navigate to the location of the MBMD file to load using the Drive, Parent, and Step Into 
buttons. 

▪ Change the way the files are displayed using the Display and Filter buttons. Reset the filter 
by tapping Clear Filter. 

▪ When the number of files exceeds the space available on the screen, scroll up and down 
within the current folder by tapping the Up and Down buttons. 

▪ Touch one of the machine configurations from those that are available, and Touch Select. 
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Materials 

 
 
Here is the list of bend technology materials and their corresponding names on the machine are 
defined. The list comes from the BT Materials library (in the Materials dialog box). 

▪ Name on Machine – The name on the control. 
▪ ID in NC – The identifier on the control. 

 
 
Punches / Dies / Holders 
These dialog boxes list the punch and die tools and holders that are currently used on the machine.  
 
For example: 

 
 
Only these columns require further explanation: 

▪ Favourite – Selected tools are the only ones visible when you Touch Favourites 
while selecting tools. 

▪ Name-on-control (NOC) – The name of the tool on the controller. Cybelec controls only 
support a single punch/die holder, so a NOC is required for the tool and a separate NOC is 
required for the holder(s) combination. 

▪ Rotated name-on-control – Only visible if the post-processor does not provide native 
support for rotating tools (e.g., the Cybelec post-processor). In this case, a separate rotated 
tool is required on the controller and you should define an appropriate NOC. 

 
Use these icons to add/remove tools/holders: 

▪ Assign tools / holders – Select from the list. 
▪ Remove assigned tools / holders. 
▪ Select punch / die holders – Only relevant for Punch holders and Die holders dialog boxes. 

If you see an error message saying that no holder can be assigned because no holder is 
configured in the database, go to the Punch holders and Die holders dialog boxes and 
assign a holder. 

▪ Remove punch / die holders – Only relevant in Punch holders and Die holders dialog boxes. 
Becomes active when you add a punch/die holder and then select it. 
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If your machine controller does not support tool holders, you can draw your tool with the holder on 
the controller. In the bending application, you give the corresponding tool + holder combination a 
name that matches the name on the machine. 
For example: 

▪ In the Die holders dialog box, add a die holder by tapping Assign and selecting a holder. 
▪ In the Dies dialog box, Touch Add Die Holders and select the holder. 

 
In Punch holders and Die holders you can stack holders on top of one another by selecting more 
than one holder. Give the combination of holders a name to match the one on the controller. 

 
 
Hemming 
Here you select the tools for prebend and flattening operations. These tools are automatically 
selected when loading a part. 
You can use the same tools for both operations by tapping Use Flattening Tools for Prebend in the 
manual tool selection dialog box. 
Tapping the Hemming Tools button opens the Hemming Tools Selection dialog box. You can read a 
full explanation in the Simulation section. 
Add and remove prebend and flattening tools/holders by tapping the and buttons on the top right of 
the dialog. 
Select the tools you want for hemming and Touch OK. The bending application fills in the Prebend 
punch, Prebend die, flattening punch, and Flattening die fields. 

 

 
 
 
Preferred 
Here you define which tools you prefer for each material and thickness on the machine. Use the 
icons: 
New Preferred Tools – Opens a dialog box where you can select the material from a dropdown list, 
type a thickness, and Touch the relevant tools for the current machine: 

 
 

▪ Edit Preferred Tools – Modify the preferred tools for this material + thickness. 
▪ Delete Preferred Tools – Delete a material + thickness combination. 
You can also define a tool as preferred while selecting tools. During manual tool selection, 
Touch the Remember as preferred tools checkbox 
All tools you have defined as preferred then appear in the Preferred Tools tab: 
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Finger Stops 
Here you configure the finger stops: 

 
 

 Default finger stop 
Select a stop from the dropdown list. The bending application uses this stop as the default 
when trying to gauge the part. 

 Fingers Z offset from part 
Sets a constant value to the Z offset. 

 Fingers R offset from corner 
Sets a constant value to the R offset from the corner. 

 R above die 
When the finger is above the die, use this offset for R. 

 Minimum gauging overlap 
The minimum acceptable overlap between the finger and the part. 

 Max distance between fingers 

 
 
Setup 
If you have saved tool station setups, you can view them here. 
To change between a table view and a card view, Touch the magnifying glass. 
To change which details are displayed, Touch Customize and de/select fields. 
You can define these setups in the Simulation Stage. 
To use a saved setup, assign it in the Tooling Stage. 

 
 
Colours 
You can define customized colours for the different parts of the display: 
Touch Use Customized Colours. 
Touch each part in turn and select the colour you want. 
To return to the default settings, Touch the Copy Defaults button. 
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Fig. 7-1: Configuration menu 

 
1. General Tool Settings 10. General 
2. Hemming and Split Bend 11. Tool Stations 
3. Export Tools  12. Tool Filter 
4. Import Tools 13. Min. Wing 
5. Punches 14. Joint Types 
6. Dies 15. Segment Names 
7. Punch Holders 16. Manufacturer 
8. Die Holders 17. Preferred 
9. Back  

 
 
Default Tool Selection 
The bending application offers three groups of tools: 

▪ Entire tool library is the library of all available tools. 
▪ Assigned Tools is a list of tools that can work with a particular machine (a subset of the tool 

library). You can select them in the Machines dialog box in the four tool tabs (Punches, 
Dies, Punch Holders, and Die Holders). 

▪ Favourite of Assigned Tools are defined per machine and are a subset of the assigned tools. 
You can define tools as favourites in the Machines dialog box in the four tool tabs (Punches, 
Dies, Punch Holders, and Die Holders). 

 
When selecting tools for specific bends, you can set the default as one of the above options. This is 
the group you see, for example, whenever you open the Tool Selection dialog box (via Auto Tools 
Selection or manual tool selection). 
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Use Configured Tool Segments Only 
When selected, this option is relevant during the Simulation Stage. It tells the bending application to 
use only tools that are in the inventory. When segments are missing, the bending application shows 
a warning and asks whether to continue. 
 
 
Automatically Divide Collinear Bend Tool 
When selected, different tools are used for collinear bends. 
 
 
Use Segment Names 
Not currently in use. 
 
 
Surround Smaller Segments with Bigger Ones 
When the bending application creates tool stations, it places the smaller tools segments in the 
middle. 
 
 
Holders True Length Display 
When selected, prior to simulation, the bending application takes the true length of the part and 
uses it to calculate collisions. When not selected, the length is always the same size of the bend. 
Therefore, the bending application uses the true length data already in the Sequencing Stage to 
check for collisions. 
 
 
Allow Tool Stations out of Machine Limits 
When selected, the tool stations can extend beyond the boundaries of the machine. 
 
 
Hemming and Split Bend Section 
In this section you define defaults for hemming and split bends. 
 
 
Prebend Angle 
This is the default for prebending a split bend. It is the angle of the product after the first bend. 
You can split prebends into two. 
 
 
Hemming Angle Tolerance 
This is the maximum permitted deviation angle for a hemming bend. 
 
 
Automatically Lock Die for Non-Hemming Hits 
Locks spring hemming dies when a part has both normal, prebend, and flattening hits. Default is 
checked. 
 
 
Punches 
This button is located on the right of the tool settings screen. 
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Punches Table 
This table shows the basic data for all the punch tools. The table includes these columns: 

▪ If any of the data has changed in a particular row, the Edited column is checked. 
▪ You can see the Punch ID, Manufacturer, Punch Name, and Up Joint. 
▪ Height includes the tang. If the values for Height and Working Height are identical, Height 

may be displaying the working height by mistake. This may be an indication that the tables 
are not up to date. 

▪ Radius is the radius of the punch tool tip. 
▪ Angle is the angle of the punch tool tip. 
▪ Max. Power is the force that each can be applied for each length. (The length unit is defined 

in the Options => Units tab.) 
▪ Hemming – when selected, this tool can be used for hemming operations. 

 
You can only change the parameters if they are user defined. The one exception is the Height. You 
can change the height of any tool because the tip of the tool may have worn down and then been 
filed down further by the customer and so the height changes. 
You can copy (duplicate) a row to a new row. Now it is user defined (there is a check in the User 
defined column) so you can change (edit) the details in this row. 

 
 
 
 

 
 

Fig. 7-2: Punch menu 

 
1. List of Punches 12. Name-on-control 
2. New Punch 13. Punch NC Properties Setup 
3. Import from factory database  14. Assign default segments 
4. Duplicate 15. Undo change 
5. Reload Tools 16. Joint Types 
6. Auto columns width 17. Segment Names 
7. Edit 18. Manufacturer 
8. Rename 19. Preferred 
9. Change Manufacturer  
10. Mirror Tool around Power line  
11. Export Tools  
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The toolbar allows you to perform several operations: 
▪ Create a punch tool parametrically or import one from a DXF file (New Punch). When you 

Touch the New Punch icon, the following dialog box opens: 

 
You can select a manufacturer and type the name of the new punch tool. When importing a 
DXF file, make sure to select the correct unit (metric or imperial). 
When defining the tool parametrically, type the values into the Tools Configuration table. In 
the Dimensions tab, type values for W1, W2, R, A, and H, and Touch Apply. 

 
 
Additional Properties Section 
The options in this section are only active when you create a tool. 
Type – Displays the tool template used as the base for the created parametric tool. If the tool is 
imported, displays Imported. 
Max. Power – The maximum power for this tool. 
Hemming – If this tool can be used for hemming, check this option, then define the type and power. 

▪ Hemming Type – Select from the dropdown list: 
1 – For two-stage hemming. 
2 – Relevant only for die tools. Indicates a spring die. 

▪ Hemming Power – The maximum power for this hemming tool. 
Description – Optional description of the new/imported tool. 

 
 
Segment Tab 
The table in this tab lets you edit the quantity of actual segments, with no heels, or with left or right 
heels, for different size segments. 
If you created the tool, you need to define the measurements and quantities in this tab. 

 
 
Dimension Tab 
This tab displays the settings for the tool measurements. 
 
 
Tool Dimensions Section 
If the selected punch tool is defined parametrically, you can edit the dimensions, as explained in the 
graphics. 
If the selected punch tool is imported, the bending application infers the dimensions from the DXF 
file and displays them. You cannot edit them. 
For example: 
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Additional Properties, Use Customized Tang 
If you want to use a tang measurement that differs from the default, check Use customized tang and 
type the height into Tang height. 
 
 
Legend Tab 
This tab is only visible when the tool is defined as a hemming tool. Here you can see a graphic 
representation of the measurements for width flattening (WF), width punch (WP), and height 
flattening (HF). 
 
 
Dies 
The explanations for this screen are very similar to the explanations for the Punches. These are the 
exceptions. 
 
 
Dies Table 
There is no Heel icon. 
The Up Joint column is replaced by the Down Joint column. 
There is a V-Width column. 
The Radius refers to the measurement at the shoulder of the die. 
For more explanations, see the Punches. 
 
 
Additional Properties Section 
This section contains these options: 

▪ Holder height – Legacy option; not in use. 
▪ Dead zone – Legacy option; not in use. 
▪ Mute position – The height at which the beam slows its downward movement and 

increases its upward movement. 
▪ Max. Power – The maximum power for this tool. 
▪ Hemming Types (for die tools only): 

1 – Two-stage hemming 
2 – Indicates a spring die 

Both options allow you to define additional parameters in the Dimensions. 
▪ Hemming Power – The maximum power for this hemming tool. 
▪ Description – Optional description of the new/imported tool. 

For more explanations, see the Punches. 
 
 
Tabs Section 
This section includes the segments and dimensions tabs. 
There is no Legend tab. 
For more explanations, see the Punches. 
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Segments Tab 
In this table you can edit the quantity of actual segments, with no heels, or with left or right heels, 
for different size segments. 
If you created the tool, you need to define the measurements and quantities in this tab. 
For more explanations, see the Punches. 
 
 
Dimensions Tab 
This tab displays the settings for the die tool measurements. 
The following picture shows an example of the power vector for a die tool: 

 
 
When the Hemming Type is 1, you can define these parameters: 

▪ H2 – The depth of the die as shown: 

 
 

▪ XOffset – The power offset from the centre for the hemming bend. 
 

When the Hemming Type is 2, you can define these moving hemming die parameters, as shown in 
the picture below: 

▪ Back Dead Zone 
▪ Front Dead Zone 
▪ Block Height 
▪ Movement 
▪ Hemming Offset 
▪ Die Notch Width 
▪ Hemming Depth 
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Punch Holders 
The explanations for this screen are very similar to the explanations for the Punches. These are the 
exceptions. 

 
 
Punch Holders Table 
When creating a punch holder tool, there is no option for defining a tool parametrically. You can 
only import tool definitions from DXF files. 
The DXF file indicates the origin for the power vector. The bending application shows the power 
vector based on the origin. 
There are columns for both Up Joint and Down Joint. 
There are no Radius, Angle, or Hemming columns. 
For more explanations, see the Punches. 
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Die Holders 
The explanations for this screen are very similar to the explanations for the Punches. 
When creating a die holder tool, there is no option for defining a tool parametrically. You can only 
import tool definitions from DXF files. 
 
 
Tool Stations 
This button opens a window where you define default configuration for tool stations. 

 
Negative Tolerance in Tool 

Stations 
Minimum Distance 

between Tool Stations 
Tool Station Offset 

   
 
When selecting tool segments 
to fit the length of a hit, the 
bending application may not 
find the exact match. The 
Negative Tolerance allows the 
bending application to select 
segments that cover less than 
the hit length, within this 
tolerance 

 
This distance helps avoid 
collisions between tool 
stations 

 
This distance is measured 
from the tool station to the 
part 

 
 

Allowable Gap between 
Segments to Achieve Hit 

Length 

Max. Distance between 
Holder Segments 

Max. Holder Segments 
Start/End Offset 

   
 
This is the maximum distance 
permitted between segments 

 
This is the maximum distance 
permitted between holder 
segments 

 
This distance is the offset 
from the start (or end) to the 
closest holder segment 

 
 

Max. Allowed Part 
Overhang 

Min. Segment Percent 
Held by Clamp 

Min. Segment Length Held 
by Clamp 

   
 
This is how much the part 
overhangs the machine on 
each side 

 
Relevant when there is a 
single clamp holding the 
punch 

 
Relevant when there are two 
clamps holding the punch 
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Automatically Centre Single Station 
When there is a single station, automatically centre it on the machine. 

 
 
Radii 
This section displays values from the bend technology table, allowing you to change the settings 
for the radii chart. 

 
 
Export/Import Radii 
You can import and export radii values from the bend technology table as TXT files. Perform these 
operations using the Import and Export buttons at the of the screen. 

 
The data in the table might resemble this example: 

 
 
Ignore Safe Flange Length Calculation 
When selected, the bending application does not consider the minimum flange length required for 
secure bending (the calculation based upon V/2 + radius allowance + thickness). Instead, the 
bending application uses the B Relative values. (See the pictures in the dialog box.) 

 
 
Radii Values Table 
The table shows the calculations from the bend technology table, multiplied by the correction 
factor for each material as defined in the Bend Technology Table. 
B Relative is the same as the Flange length security calculation, as shown in the figure on the right 
of the screen. 
The values in this table are based on material of type 1 (steel). 

 
 
Joint Types 
This button opens a window where you can view and edit joint types. 

 
 
Joint Types Section 
You can customize the joint types: 

▪ To add the name of a new joint type, Touch New Joint Type icon. 
▪ To change the name of any joint type in the table, Touch the Rename Joint Type icon. 
▪ To delete a joint type that you created, Touch the Delete icon. This option is only active 

when you have defined at least one joint type. 

  



 
 

User Manual 

VisiTouch MX – User Manual 

MAY 
2020 
V1.2 

71/97 

Configured Joint Types Table 
The table shows you all the joints types, including ones you have defined. 
You can see the name of each joint type, whether it is suitable for upper or lower beams, if it is 
rotatable, and (optionally) a description. 
When you create a new joint type and Touch OK, the bending application assigns the joint type a 
numeric ID. 

 
 
Segment Names 
The Defined Segment Names table contains columns for Segment Length, Metric Name, and 
Imperial Name, to make it easy to refer to a particular length. For example, segment length is 
called ½” in Imperial measurements. 
To define a new segment name, Touch it. 

 
 
Makers 
The table at the top of the screen shows default segments per punch manufacturer. 
The table at the bottom of the screen shows default segments per die manufacturer. 

 
 
Default Segments Tab 
This button opens a window to show the number of default segments for each measurement. 
For punch tool manufacturers, the table also shows the number of default left and right heels. 
Add a new segment by tapping the empty line at the bottom of the table. 

 
 
Heel Setup Tab 
Relevant for punch only. 
Heels are defined differently for each tool manufacturer. 
You have these options: 

▪ Assign a heel manufacturer to selected tools. 
▪ Change a default length or normal/left heel/right/heel position by tapping the field and 

typing the new value. 
▪ For a punch tool, define which type of heel setup to use by tapping the Heel Setup tab 

and selecting one of the options: 
 

 
 
The graphic on the left shows you the measurements based on the heel type. Edit the displayed 
values. 
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Miscellaneous Tab 
To change the name of the punch/die manufacturer, type the name into Manufacturer name. 
To set the tang height, type the value in Tang height. 

 
 
Preferred 
To add New Preferred Tools, Touch and select a machine/material/thickness combination: 

 
 
Later you can change the combination or delete it. 
When you are in Simulation Stage, to indicate a preference for specific tools, Touch the Remember 
as preferred tools button: 

▪ In the manual tool selection 
▪ In the auto tool selection 

 
 
My Preferred Tool Table 
The table shows the preferred tools you selected in the manual tool selection for a particular 
material/thickness combination, sorted by machine. For example: 

 

 
 
To change the order of the machines displayed in the table, Touch the Machine button. 

 
 
Materials 
When you Touch Materials, you are prompted to Touch a password and Touch Enter. You can get 
this password from your system administrator. 
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The Materials dialog box contains the data for each material, including tensile strength and 
density: 

 
 

 
 

Fig. 7-3: Material menu 

 
1. List of materials 4. View/Edit BT Materials 
2. New 5. Set as Default 
3. Rename  6. Delete 

 
 
Bend Technology Materials 
 
 

 
 

Fig. 7-4: Bend technology materials menu 

 
1. List of materials 3. Rename 
2. New 4. Delete 

 
 
You can delete a technology material only if it is not being used by one of the materials in its BT 
Materials setting. So, before you can delete a technology table change that material’s setting or 
delete it altogether. 

  

2 3 4 5 6 

1 
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You can also edit the properties' technology materials by typing new values in the appropriate 
field: 

▪ Overbend Factor – The overbend for this technology material. This will be the value for all 
materials that use this technology table. 

▪ Correction Factor – The correction for this technology material. This will be the value for 
all materials that use this technology table. 

 
 
Overbend Factor 
The bending application uses the overbend factor to calculate the overbend angle. 
After the machine presses the material, the bend opens to some extent due to the material’s 
flexibility (the spring back). The overbend angle is the difference between the angle to which the 
part must be pressed and the desired final angle. 
 
Below is an example of bending 5 mm (0.2") armour plating, which has a very high overbend 
factor.  

 

  
To achieve a bend with an angle of 90° it is 
necessary to press the material to a product 
angle of about 61 

When the beam moves up, the material 
relaxes, springing back to the desired angle. 
 

 
Delta = Punch Radius / (Thickness * 2.1); 

▪ Formula from "Press Brake Technology - Steve D. Benson" pages 96-100. 
Spring Back = Delta * Over bend Factor  
Spring Back = (overbend Factor ∗ Punch Radius) / (Thickness ∗ 2.1) 

 
 
Correction Factor 
To select the correct die width for a specific bend, the bending application relies on the Radii 
Values table in the Tools dialog box. 
 
When creating the flat of a part, the bending application examines each bend and selects the 
correct die width. The bending application uses this die width to select the correct value from the 
Compensation Table. 
 
Because there is only one Radii Values table, the bending application must make allowances for 
the properties of different materials. To achieve a bend radius of 2 mm (approx. 0.08") for mild 
steel requires a V16 die (0.623"), while for aluminium it might require a V12 (0.472") die. 
 
The Correction Factor determines how to select the correct die width, adjusted to the specific 
material of the part. The bending application takes a given radius (r), multiplies it by this factor, 
and arrives at the radius for this material (rM): 

rM = r * Correction Factor 
 
The bending application then finds the correct die width for this adjusted radius in the Radii Values 
table. 
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For example, this is the default Bend Technology table: 

 
 
For a bend with a radius of 1.2 mm, the bending application makes the following selections: 

 

 
 
So, for aluminium you get V8, for steel V10, and for stainless V12 (if there is no exact match then 
the bending application takes the next largest). 

 
 
 
This button opens the Bend Compensation Factor Setup dialog box: 

 

 
  

Bend Comp 
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Towards the top of the dialog box you can choose the mode for calculating the bend 
compensation. Options: 

▪ ISO (DIN 6935): 
Ri/e <= 0.5   0.8   1.2     2      3   >= 5 
K        0.5      0.6    0.7   0.8   0.9      1  
Where Ri is internal radius, e is thickness and K is the compensation factor. 
 

▪ Constant: K*e/2, where K is the compensation factor and e is the thickness. 
▪ Rolleri: Special constant 
▪ Bend compensation table: Use values from bend compensation table related to material, 

thickness, punch radius, and V width. 

 
This dialog box contains bend factors tables, based on the material and thickness combination. If 
you change either of them, the data in the table changes accordingly. 
There are also three compensation display modes: D, D/2, and E; where D stands for Bend  
 
Deduction and E is the calculation visible at the bottom of the screen: 
 

 
 
You can create a new entry in the table based upon an existing entry. 
 
 
 
In this screen you can view saved station setups that you saved in the Simulation Stage. 

  
Stations 
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Here you will find the main screen of the machine configuration. 

 
 

 
 
 
 

Fig. 8-1: Main menu 
 

3. Orientation view 5. Import machine menu 
4. Material management 6. NC Output management 
5. Punch management 7. Lower / Upper clamp configuration 
6. Die management 8. R axis configuration 
7. Upper clamp management 9. General machine parameters 
8. Lower clamp management 10. Main menu 
9. Hemming management 11. Back button 
10. Preferred tools menu 12. Machine components menu 
11. Fingers management 13. Equipment’s name 
12. Tool station setup 14. Load machine from library 
13. Colours management 15. Edit machine component 
14. 3D / Static view 16. Select machine component 
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Every machine in VisiTouch 19 MX has six basic components: 
 
 

Frame Lower Beam Upper Beam 

   
 
 

  

Upper Clamp Lower Clamp Fingers 

 

 
 

 
 
 
 
Before importing, the geometries should be prepared in several ways: 

1. Simplified – only the bare minimum should be left, leaving out anything which has no 
bearing on collision detection, specifically: 
a. Holes, in frame or beams or as shown in the Lower Clamp above. 
b. Elements at the back of the frame, e.g. supports or cabinets. 

2. No arcs – all arcs should be re-drawn as segmented planes (to make 3D analysis simpler): 
 

A frame’s throat with arcs and after segmenting to planes: 

  
                  

3. Coordinate system – all components should use the same coordinate system, the origin 
position depending on their type, with axis directions being: 
a. X – positive pointing from machine to the operator. 
b. Y – positive pointing up. 
c. Z – positive pointing from centre toward the left of the machine. 

 
Once all components are defined in this way, they must be exported to IGS format. 

BASIC MACHINE COMPONENTS 

PREPARING COMPONENTS FOR IMPORT 



 
 

User Manual 

VisiTouch MX – User Manual 

MAY 
2020 
V1.2 

79/97 

 
 
The origin of the Lower Beam should be defined as follows: 

1. Y = 0 is where the clamping system connects. 
2. X = 0 is where the force vector presses. 
3. Z = 0 is in the middle of the beam. 

 
Usually it will thus: 

 
 
Once the IGS file is ready, do: 

1. In the Home tab, select the Lower Beams button: 
 
 
 

2. Click on New: 
 
 
 
 

3. Input a Manufacturer name, select Defined by IGS and use the Import IGS button to 
select the beam’s IGS file. 

4. After selecting the file, the Define New Lower Beam dialog will open. 
5. Enter a value for Z – the working length of the beam. 

 
 
 
The origin of the frame should be in the position where the Lower Beam’s origin would be in the 
assembled machine: 

 

 
 

Once the IGS file is ready, do: 
1. In the Home tab, select the Frames button: 

 
 
 

2. Click on New: 
 

 
 

3. Input a Manufacturer name, select Defined by IGS and use the Import IGS button to 
select the frame’s IGS file 

  

DEFINING AND IMPORTING A LOWER BEAM 

DEFINING AND IMPORTING A FRAME 
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The origin of the Upper Beam should be defined as follows: 

1. Y = 0 is where the clamping system connects. 
2. X = 0 is where the force vector presses. 
3. Z = 0 is in the middle of the beam. 

 
Usually it will thus: 

 
 
Once the IGS file is ready, do: 

1. In the Home tab, select the Upper Beams button: 
 
 
 

2. Click on New: 
 
 
 
 
 

3. Input a Manufacturer name, select Defined by IGS and use the Import IGS 
button to select the beam’s IGS file. 

4. After selecting the file, the Define New Upper Beam dialog will open. 
5. Enter a value for Z – the working length of the beam. 

  

DEFINING AND IMPORTING AN UPPER BEAM 
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Whereas frames and beams are regular IGS solids, a Lower Clamp file must be a Planar Surface. 
 
To create a planar surface part in SolidWorks, do: 

1. Make a Sketch with the clamp’s profile. 
2. Select the Sketch element then select Insert => Surface => Planar 

 

 
 

3. Once this is done you will see an element like this: 
 

 
 
The origin of the Lower Clamp should be defined as follows: 

1. Y = 0 is where the die connects. 
2. X = 0 is where the force vector presses. 
3. Z = 0 is toward the left, as the clamp sits on the lower beam. 

 
Usually it will thus: 
 

  
  

DEFINING AND IMPORTING A LOWER CLAMP 



 

User Manual 

VisiTouch MX – User Manual 

MAY 
2020 
V1.2 

82/97 

Once the IGS file is ready, do: 
1. In the Home tab, select the Lower Clamps button: 

 
2. Click on New: 

 
 
 

 
3. Input a Manufacturer name, select Defined by IGS and use the Import IGS 
4. button to select the clamp’s IGS file. 
5. After selecting the file, the Define New Lower Clamp dialog will open: 

 

 
 

6. Enter a value for: 
a. H – the height between the lower beam and the die. 

If these are clamping plates, then set this to 0.01 – a nominal 0. 
Then the clamp will be positioned like this: 
 

 OR  
 

b. Clamp Length – the length of each clamping piece. 
i. Clamping plate – enter the length of the plate. 
ii. Full length clamp (e.g., Wila) – does not matter, can remain as “0”. 

 
c. Symmetric – can the die be rotated in place on this clamp. 
d. Joint Type – which connector the clamp uses for holding tools: 
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Whereas frames and beams are regular IGS solids, an Upper Clamp file must be a Planar Surface 
(see above how to define such a part). 
The origin of the Upper Clamp should be defined as follows: 

1. Y = 0 is the point from where the Working Height of punch is calculated (so 
for Wila\Trumpf clamps this may be inside the clamp or at its bottom). 

2. X = 0 is where the force vector presses. 
3. Z = 0 is toward the left, as the clamp sits on the upper beam. 

 
Usually it will thus: 
 

 

OR 

 

OR a clamping 
plate 

 
 

 
Once the IGS file is ready, do: 

1. In the Home tab, select the Upper Clamps button: 
 
 
 

2. Click on New: 
 
 
 
 

3. Input a Manufacturer name, select Defined by IGS and use the Import IGS button to 
select the clamp’s IGS file. 

4. After selecting the file, the Define New Upper Clamp dialog will open: 
 

 
  

DEFINING AND IMPORTING AN UPPER CLAMP 
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5. Enter a value for: 
a. H – the height between the upper beam and the punch. 

If these are clamping plates, then set this to 0.01 – a nominal 0. 
Then the clamp will be positioned like this: 

 
b. Clamp Length – the length of each clamping piece. 

i. Clamping plate – enter the length of the plate. 
ii. Full length clamp (e.g., Wila) – does not matter, can remain as “0”. 

 
c. Symmetric – can the punch be rotated in place on this clamp (so for Wila this will 

be “True”, for Euro one sided “False”). 
 

d. Joint Type – which connector the clamp uses for holding tools: 
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The origin of the finger should be in the position where the machine control “thinks” it 
is, so when the control moves the finger to (X = 100, R = 100, Z = 1000) the origin of the 
geometry should be the point that is brought to that position. 
 
Usually, the origin of the finger will be defined as follows: 

1. Y = 0 is at the bottom of the first stop. 
2. X = 0 is at the front of the first stop. 
3. Z = 0 is determined according to the (actual, physical) machine configuration. 

 
Possible origins are: 
 

   
 

To define a finger requires defining the individual stops and the relationship between 
them. 
 
There are two types of stops: 

1. Flat stop: 

 
 

2. Cylindrical stop: 

 
Fingers are the only geometry when it is permitted to have arcs. 
 

For example, in the following (partial view of this) finger there are 6 stops: 

 

1 and 4 are flat stops, while 2, 3, 5 and 6 are cylindrical. 
In addition, the pairs 2-3, 5-6, have a relationship – they are used for clamping (“crab 
claw” gauging) and have to be defined as such. 
Defining 2 and 3 with a Crab Claw connection allows them to clamp a part thus: 

  

DEFINING AND IMPORTING FINGERS 
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Once the IGS file is ready, do: 

3. In the Home tab, select the Fingers button: 
 
 
 

4. Click on New: 
 
 
 
 

5. Input a Manufacturer name, select Defined by IGS and use the Import IGS button to 
select the clamp’s IGS file. 

6. After selecting the file, the Define New Finger dialog will open: 

 
 

7. Now you must define each stop on the finger. 
8. Defining a Flat stop: 

a. Name – the first stop is usually called “Stop”. 
b. dX – distance from the front of the face to the origin along the machine X axis (so 

positive is front-to-back). If this is the first stop then this will be 0. 
c. dR – distance from the bottom of the face to the origin along the R (i.e. Y) axis. If 

this is the first stop then this will be 0. 
d. dZ - distance from the centre of the face to the origin along the machine Z axis 

(so positive is left-to-right). This value depends on the position of the origin.  
In this example this is 22mm, as the origin is at the left of the stop: 

 
 

e. Width – the width of the face; in this example this is 44mm: 
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f. Height – the height of this stop; in this example this is this 10mm: 

 
 

g. In this finger there is another flat stop – the support (highlighted below):  

 
The definition for this stop is: 

 
 

9. Defining a Cylindrical stop:  
The following show the definition of this stop: 
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the values for this stop are: 

 
 

a. Name – designation for this stop. 
b. dX – distance from the centre of the cylinder to the origin along the machine X 

axis (so positive is front-to-back): 

 
c. dR – distance of bottom of face to origin along the R (i.e. Y) axis. If this is the first 

stop then this will be 0. 
d. dZ - distance of centre of cylinder’s arc to origin along the machine Z axis (so 

positive is left-to-right): 

 
e. Height – the stop’s height. 
f. Radius – the radius of the cylinder’s arc: 

 
g. Start at – the angle where the cylinder’s arc begins, with the arc going counter-

clockwise: 

 
h. End at – the angle where the cylinder’s arc terminates: 

 
i. Claw with – if this stop is used to clamp with another stop. If this is the first 

Cylindrical stop then this option will be disabled. 
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j.  
 

10. In this finger there are another four cylindrical stops.  
The following show the definitions of this stop:  

 
 
 
This cylinder has these dimensions: 

 
 
So, the values for this stop are: 

 
 
Note that the Claw with setting now has a value – “Crab1”. If you now return to the 
definition for Crab1 you will see that it now has a complimentary Claw with setting – with 
Crab2. 
 
When you define the fourth cylinder, you will also have to define the Claw With value, 
but this time it will be set to “Crab3”: 

 
 

After defining all the stops for this finger, the result will be: 
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As mentioned above, the dZ value is measured along the machine’s Z axis, with positive being left-
to-right, from origin to centre of the face or cylinder. 

 
 
So, the dZ values for stops in the finger are thus: 
 

  
  



 
 

User Manual 

VisiTouch MX – User Manual 

MAY 
2020 
V1.2 

91/97 

 
 
 
 

 
In order to import a DXF or DWG into VisiTouch 19 MX it must comply with several rules: 

1. Must be a representation of the flattened part, not a profile or folded. 
2. Must be divided into layers, where each layer contains an only one type of objects; 

the objects are: 
a. Part contour – outer contour, inner holes. 
b. Bend lines – can be bends with different angles on the same layer 

3. Contour lines must be closed – no open geometries. 
4. Each bend line must have a Text object positioned next to it, specifying its 

parameters. 
5. The Text object must be very small and as close as possible to the centre of the 

bend line. 
6. The bend parameters’ format must be: 

a. Bend angle – can be in one of two formats, in CAPS or not: 

 
i. Product angle: 

1. Text format:   ap = <nn> 
2. Example:   ap = 135 

ii. Bending angle: 
1. Text format:   ab = <nn> 
2. Example:   ab = 45 
 

b. Bend radius 
i. Text format:    R = <nn> 
ii. Example:    R = 0.8 

 
7. The file may include geometries that can be ignored during the import, but these 

must be on a separate layer. For example, this file has a layer with the sheet layout: 

 
  

PREPARING A DXF \ DWG FILE FOR IMPORTING INTO VISITOUCH 19 

MX DEFINING AND IMPORTING FINGERS 
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during the import into VisiTouch 19 MX this layer can be set to “Ignore”: 

 
 
and you get only the part geometry and bend lines: 

 
 

8. The file may include text objects that denote Thickness or Material, and these can 
then be read by VisiTouch 19 MX during the import. For example, the DXF may 
include T = <thickness> and M = <Material>: 
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9.  

 
 
During the import these (and additional) designations can be mapped in VisiTouch 
19 MX to the corresponding properties: 
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Examples of DXFs: 
Good formatting: 
 

 
Each bend line has a text object that clearly belongs to it. 

 
Bad formatting: 
 

1. The problem: 

 
Texts from different bend lines overlap, making it unclear where they 
belong. 
 
 

2. The problem: 

 
The angles are given by "A=" instead of Ap= or Ab= (or AP, Ap, ap, etc.) 
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3. The problem: 

 
No bend information, all lines are on the same layer. 
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  Please subscribe to our YouTube channel to have our latest videos and tutorials. 

 

   https://www.youtube.com/channel/UCLBu-RxCGGf_epuHtMwoAcQ 

 

   Don’t forget to click on the ring bell button to stay in touch! 

 

 

 

 

 

  Your feedback is very important for us in order to improve our equipment. 

Please, let us know if you have any suggestion  

Mail us to our support: support@cybelec.ch  

  

RESOURCES 

TUTORIALS - VIDEOS 

FEEDBACK 

https://www.youtube.com/channel/UCLBu-RxCGGf_epuHtMwoAcQ
mailto:support@cybelec.ch


 
 

User Manual 

VisiTouch MX – User Manual 

MAY 
2020 
V1.2 

97/97 

 

© 2019 Cybelec S.A. 

All Rights Reserved 

Copying, reproduction, modification, distribution, display or transmission of any of the contents of this manual for 
any purpose without the prior consent of Cybelec S.A. is strictly prohibited. 


